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Introduction

One of the problems arising from the intensive use of fungicides is the selection of 
biotypes of the target fungus that are resistant to the fungicides being used.    This is 
particularly a problem with the new systemic fungicides with specific, single-site 
biochemical modes of action.

The only sure way to avoid problems with fungicide resistance is to avoid using fungicides, 
or at least avoid using those fungicides that are "vulnerable" to fungicide resistance.    
There are important reasons for using these fungicides, however, so avoiding their use is 
not a satisfactory solution to the problem of resistance.    The alternative is to learn to 
manage the resistance and to obtain maximum benefit from the fungicide without 
selecting a fungus population with a high frequency of resistance.

Unfortunately, there are few general rules for managing fungicide resistance.    First, the 
fungicides themselves vary widely in their biochemical modes of action and the spectrum 
of organisms against which they are effective.    Secondly, different fungi differ widely in 
their capacity to produce fungicide resistant biotypes. If we truly want to manage 
resistance, we must consider each fungus and each fungicide on a case-by- case basis.

There are several factors that affect the rate at which the frequency of fungicide resistance
increases to the point where disease control becomes a problem.    The first is the initial 
frequency of resistant individuals in the fungal population.    It matters little whether those 
individuals existed before the fungicide was used or whether a fungicide-resistant biotype 
arose by a chance mutation some time after the fungicide had been in use. In either case 
what is important is the proportion of the propagules of the fungus that are of the resistant
(or, if you prefer, "less sensitive") biotype at any point in the epidemic.

The second factor is the rate of selection of the resistant biotype, that is, its relative 
success in surviving and reproducing (compared with the sensitive biotype) in the 
presence of the fungicide.    This is affected by the dose of the fungicide (the higher the 
dose, the less chance for "escapes" of the sensitive biotype) and by the level of resistance 
expressed in the resistant biotype.    For example, if the lethal dose for the resistant 
biotype were 100 times that required for the "wild type", we would expect to see a faster 
rate of selection than if the resistant biotype were killed by only twice the dose required to 
kill the wild type.

The third factor is the fitness of the resistant biotype relative to the sensitive biotype in the
absence of the fungicide. This affects the rate at which the resistant population "reverts" 
to the wild type without continued selection by the fungicide to which it is resistant.    The 
effect of fungicide resistance on the fitness of the fungus varies quite widely, depending on
the biochemical basis of resistance.    For example, many fungi resistant to benomyl seem 
to be nearly as ecologically fit as their benomyl- sensitive counterparts,    whereas some of 
the fungi resistant to some of the dicarboximide fungicides appear to gain that resistance 
only at great metabolic cost, and they are far less able to compete in the absence of the 
fungicide than are their corresponding wild types.



Before Beginning the Season

At this point, the simulated season has not yet begun.    By selecting Run from    the File 
menu, the simulation can be executed using the current values of all variables as shown in 
the menu system.    These values can be examined and/or changed by selecting the 
appropriate menu item.    You can select up to two fungicides for use during the coming 
season by choosing Select... from the Fungicides menu.    By selecting Schedules..., 
you can set the dates and rates of fungicide applications.



During the Season

While the simulator is running, many of the menu items will be grayed and disabled.    This 
is because it would not be appropriate to change parameters in mid-season.    New may 
still be selected and has the same effect as at any other time: it takes you back to the 
beginning of year one.    You may exit Resistan while the simulator is running.    The 
Subpopulation     Calculator   may be used during the season to determine what 
percentage of the population has a specified combination of    resistance characteristics.

The main window shows a line graph where the x-axis is the day of the season and the y-
axis is a relative scale from 1 to 100.    The most important control at this point is the scroll 
bar just below the x-axis.    Clicking on the arrow at the right end of this scroll bar will cause
the simulation to advance by one day.    Clicking the page-up area will advance by one 
week; or dragging the thumb will allow you to go to an arbitrary date.    Just as in the real 
world, you can't go back in time.    If any fungicide applications have been scheduled, you'll
see a triangular nozzle for each one hanging from the x-axis.    The nozzles can be dragged,
changed, inserted or deleted to modify the spray schedule that was set up before the 
season began.    (See Fungicide Schedules.)    

As the season progresses day-by-day, lines are plotted for the residues of the fungicides, 
the frequencies of resistance to the fungicides, the number of lesions, and the cumulative 
percent of crop damage.    To convert the relative values plotted on the graphs for residues 
to absolute units, multiply the relative value by the scaling factor for that residue 
displayed in the View menu. For percent resistance and percent crop loss, the y-axis 
values need no scaling.

Because the lesion population may cover a very broad range of values in a single season, 
when it approaches the top of the graph it will "wrap around" to the bottom.    Each such 
break in the lesion line represents a ten-fold increase in the scaling factor.    Hence, if the 
lesion line is shown as three distinct line segments, y-axis values should be multiplied by 1
for the first segment, 10 for the second segment, and 100 for the third segment.    
Rescaling without redrawing the entire graph avoids a considerable loss of resolution in the
early season part of the display.    It also causes the slope of the line plotted to decrease by
a factor of ten with each rescaling.    Hence, if the lesion population is growing at a 
constant rate throughout the season and goes off scale a few times, there will be an 
apparent leveling out toward the end of the season.    Differences in slope between 
discontinuous segments of the lesion line should be interpreted with caution. 



The End of the Season

At this point, you can:

1.    View the economic analysis pie chart (Economics menu)

2.    Create an ascii text log of the season (File menu)

3.    Continue with the simulation by choosing Continue (File menu).    When you choose 
run, you will be prompted to save the season to disk.    You will also be asked if you want to
look at and/or change any variable values.    If you respond by clicking Yes, you'll be given 
access to the full menu system before beginning the next season.    If you click No, the 
next season will begin immediately using the current values for all variables.



Run/Continue

Selecting Run in the File menu will cause the simulator to begin execution.    When you do 
this, the first item in the File menu will change from Run to Continue.    The most 
important control at this point is the scroll bar just below the x-axis.    Clicking on the arrow 
at the right end of this scroll bar will cause the simulation to advance by one day.    Clicking
the page-up area will advance by one week; or dragging the thumb will allow you to go to 
an arbitrary date.    Just as in the real world, you can't go back in time.

 Resistan starts with default values for all of its variables, so you can run your first season
simply by selecting Run.    Once you become acquainted with the program, you'll want to 
apply different fungicides, change spray schedules or even change the characteristics of 
the fungus or fungicides.    As the simulation progresses, it is possible to observe day-by-
day the number of lesions and the percent resistance to each of the fungicides in response
to the spray applications.    At the end of the simulated season there is a cost accounting 
that can be used to compare different spray schedules on a cost/benefit basis.    If you 
want to test a spray program over a period of several growing seasons, Resistan will 
simulate the overwintering of the inoculum and carry over the resistant populations from 
one year to the next. You might then want to repeat the entire sequence, testing a 
different proposed spray schedule, perhaps including tank-mixes of fungicides, alternating 
fungicide sprays, or implementing a program of reduced doses or fewer sprays of the at-
risk fungicide.



New

New allows you to begin a new simulation.    Selecting New in the File menu will return 
the program to the beginning of year one, just as if you had exited the program and 
restarted.    Just as when you start the program initially, if a file named STARTUP.RSS is 
found, it will be loaded; otherwise, the built-in default values will be restored for all 
program variables and options.    You may want to use the Save As... command before 
selecting New so that you can recall the current season at a later time.



Open

Open allows you to open a saved Resistan document in which is stored the state of the 
program at the moment you executed the Save As command in a previous run.    This 
includes all program options and parameter values.    If the season was in progress when 
the document was saved, opening it will return you to the day on which it was saved.    
(This is a good way to explore and compare different management strategies.)



Save As...

Save As creates a Resistan document on disk using the name and extension you provide.
Use of the .RSS extension is strongly recommended to distinguish Resistan documents 
from other types of files.    If you add a line for the .RSS extension to the [extensions] 
section of your WIN.INI file, you will be able to start Resistan simply by double clicking a 
document.

A Resistan document contains the complete state of the program at the time the 
document was saved.    If you save a document named STARTUP.RSS, Resistan will load it 
automatically when you start the program.    In this way, you can override the default 
values provided for the various parameters and options.

A document saved before selecting Run will contain only the program options and initial 
parameter values and will take considerably less space on disk.    A document saved while 
a season is in progress will contain all information for that season up to the time when it 
was saved.



Log to Disk

A plain text record of all parameter values and day-by-day simulation results can be saved 
to disk using the Log to Disk... selection in the File menu.    This is especially useful for 
preparing printed reports.    Whether you choose Log to Disk before a season is started, in
the middle of a season, or at the end of a season, the log file will include all initial values 
and results from the beginning of the season onward.    If the log is closed before the end of
the season, only the data up to the day when the log was closed will be saved.    A single 
log file can be used to record the results of several successive seasons.



Exit

This selection terminates Resistan.    The same thing may be accomplished by double 
clicking the close box in the upper left corner of the Resistan window.



Selecting Fungicides

In the Fungicides menu, Select will bring up a dialog box with two select controls, one for
either of the two fungicides that    may be applied.    Clicking on the "chasing arrows" icon 
or the fungicide name will scroll the selection.    When you are done, click OK to accept the 
selections as shown, or CANCEL to end the dialog without changing selections.



Fungicide Schedules

Scheduling spray applications is accomplished in two different ways, depending on 
whether or not you have already begun simulation of the season.    Before the beginning of 
the season, you can alter the schedule and/or rates of application of any of the available 
fungicides through the fungicide schedules dialog box.    Once the season has begun, this 
dialog is no longer available.    Instead, you will see a series of triangular controls hanging 
beneath the x-axis.    These are spray nozzles, which will apply the indicated fungicides as 
the simulation progresses past them.    Alteration of the spray schedule during the season 
is accomplished by manipulating these nozzles.    Both methods of changing the spray 
schedules are described in more detail below.

Selecting Schedules in the Fungicides menu will enable you to examine or modify the 
spray schedules for all of the available fungicides. Clicking on the select control (indicated 
by the "chasing arrows") at the top of the Fungicide Schedules dialog box will scroll you 
through the different schedules.    You may apply any fungicide up to 20 times in a season.  
Dates are specified in days from the beginning of the season, and doses are in units of 
active ingredient per unit land area.    To enter a large number of dates on a regular 
schedule, click the Dates button.    This will allow you to set all dates based on a beginning
date and interval that you provide.    If fewer than twenty applications of a given spray are 
scheduled, some of the "Day" positions will be occupied by zeroes. The Doses button 
allows you to specify a single dose to be used for all applications.    If the spray date for an 
entry is set to zero, no spray will be applied regardless of dose.    When you are satisfied 
that all schedules are as desired, click OK.    Cancel will discard any changes made to the 
spray schedules.

While the simulation is in progress, you can change spray applications by manipulating the
spray nozzles.    Note that the color of a nozzle indicates what fungicide(s) it will apply.    
The colors used for the spray nozzles are the same as those used to represent the 
fungicide residues on the graph.    The date of an application can be changed by dragging 
the nozzle to the left or right.    Double-clicking a nozzle opens its dialog box, which 
contains an edit control and a check box for each selected fungicide.    The edit control lets 
you change the rate of application while the check box determines whether the fungicide 
will be applied.    If no fungicide is checked when you click the OK button, the nozzle will be 
removed from the graph.    Double-clicking anywhere along the x-axis (except on an 
existing nozzle) will create a new nozzle.    Only nozzles which have not yet discharged 
their spray can be changed; as in the real world, you can't change history.



Fungicide Characteristics

The parameters that characterize the fungicides in Resistan can be changed to represent 
any fungicide of your choice.    This is done by selecting Characteristics... from the 
Fungicides menu.    The individual fungicide characteristics are described in the following 
help items.



Fungicide Name

Fungicide names may be changed in the Fungicide Characteristics dialog box.    
Fungicide names may not exceed 20 characters.



Fungicide Cost

Fungicide Cost is used in the benefit-cost analysis at the end of the simulation.    The 
monetary units and the units of measure of the fungicide can be any arbitrary units that 
are consistent with the other units used in the simulation.    The default units are dollars 
per pound.



Dose->Deposit Factor

The Dose->Deposit Factor converts the application dose of the fungicide to a deposit on 
the leaf surface.    It can be calculated by dividing the measured deposit in micrograms per 
square centimeter of plant surface immediately following a spray by the application dose.   
The units in which the application dose is expressed (both the quantity of fungicide, and 
the unit of land area) may vary, as long as the same units are used consistently 
throughout the program.    The default application doses are expressed in pounds of active 
ingredient per acre.



Weathering Rate

The Weathering Rate expresses the rate at which the fungicide residue disappears from 
plant surfaces as a proportion lost per day (the exponent in a negative exponential 
function).    It is estimated by regressing the natural log of the measured residue in 
micrograms per square centimeter of plant surface versus time in days following the 
application.    This parameter is the negative slope of the regression line, and should 
represent an "average" from different parts of the crop canopy and following a wide range 
of environmental conditions.

In the simulation, the residues of the fungicides are calculated as follows:

resid(f) = resid(f) - attenu(f) * resid(f)

where resid(f) is the residue of each of the fungicides (f) in micrograms per square 
centimeter and attenu(f) is the attenuation rate of each fungicide (proportion lost per day).
The time step for this state equation is one day.



ED50 for Spore Mortality

Simulation of the dose-response to the fungicide assumes that the probit kill is a linear 
function of the logarithm of the dose, a function that can be described with two 
parameters, a slope and an ED50 intercept.

probit(f,r) = 5 + slope(f) * log10 (resid(f) / ed50(f) / reslev(f,r))

This function is evaluated for each fungicide and for the subpopulations sensitive and 
resistant to each fungicide (f,r).    Reslev is the resistance level, which is 1.0 for the 
sensitive biotype and greater than one for the resistant biotype.    Probits are then 
transformed into proportion kill of each biotype (sensitive or resistant) by each fungicide, 
kill(f,r).

Despite the fact that a probit/log dose function does not always represent a good fit of the 
response of a fungus to a fungicide, this is one of the approximations that is made to 
simplify and streamline the simulation.    The dose must be expressed in micrograms of 
fungicide per square centimeter of surface, and the response in proportion of the 
population killed.    Probit kill is then regressed versus log10 of the dose.    Two parameters 
are then estimated, the slope of the regression line and the ED50.

The ED50 of the fungicide in micrograms per square centimeter of leaf surface is the 
antilog of the point on the ordinate that corresponds to probit 5 on the abscissa, and 
depends on the target fungus.



Dose-Response Slope

The Dose-Response Slope is the slope of the probit kill / log dose function for the target 
fungus.    (See the previous item.)



ED50 for Inhibition of Lesion Development

Fungicide inhibition of lesion development is simulated as a saturation function:

inhbles(f,r) = resid(f) / (ed50les(f) * reslev(f,r) + resid(f))

where ed50les(f) is the fungicide dose that gives 50% inhibition of lesion development (the
half-saturation constant) and reslev(f,r) is the resistance level.    (The resistance level of the
sensitive biotype is 1.0)



ED50 for the Inhibition of Sporulation

Fungicide inhibition of sporulation is simulated as a saturation function:

inhbspo(f,r) = resid(f) / (ed50spo(f) * reslev(f,r) + resid(f))

where ed50spo(f) is the fungicide dose that gives 50% inhibition of sporulation (the half-
saturation constant) and reslev(f,r) is the resistance level.    (The resistance level of the 
sensitive biotype is 1.0)



Mutation Rate

The Mutation Rate represents the rate at which mutation to the resistant biotype occurs. 
It is expressed as a percentage, and serves as a lower limit on the percent resistance in 
the fungal population.



Resistance Level

The Resistance Level is the factor by which the ED50 of the sensitive biotype is 
multiplied to get the ED50 of the resistant biotype.    For example, if the resistant biotype 
required 100 times the dose to achieve the same level of control as the sensitive biotype, 
the resistance level would be 100.



Fitness of the Resistant Biotype

Fitness of the resistant biotype can affect all three stages of fungal development; 
spore survival, lesion development and sporulation.    The effect on spore survival is used 
as a factor in determining the daily survival rate of spores.    The effects on lesion 
development and sporulation are used as factors in determining the flow from one growth 
stage to the next.    All three factors are expressed as proportions ranging from 0 to 1.    If 
the resistant and sensitive biotypes are equally fit, the factor is one.    The relative fitness 
of the resistant biotype cannot be measured or estimated easily from laboratory or field 
experiments.    It is most easily estimated by repeatedly readjusting the fitness factors 
after running Resistan until the simulated rate of reversion to the sensitive biotype 
approximates that observed in the field.



Fungicide Resistance

The percent of the sporulating lesion population resistant to each fungicide can be set at 
the start of each season.    (The default is the mutation rate set under Characteristics... 
in the Fungicides menu.)



Inoculum

The initial inoculum in spores per unit of simulated area (acres or hectares) at the start of 
each season can be read (from the simulated overwintering) or can be set to the desired 
value.    The total number of spores given will be released uniformly over the period given.

Inoculum blown in from outside the simulated area is sensitive to all the fungicides.



The Fungal Life Cycle

By adjusting the parameters that describe the fungus life cycle, Resistan can be made to 
simulate any fungus that has multiple cycles of infection during a single season.    These 
changes can be made by selecting Life Cycle... in the Fungus menu.



Infection Efficiency

The Infection Efficiency is the proportion of landed spores that successfully infect per 
day.    It is estimated by depositing a known number of spores on a susceptible surface and 
counting the infections that result following incubation in a favorable environment.    The 
parameter is the number of infections per deposited spore.



Latent Period

The Latent Period is the time from initiation of infection until a sporulating lesion 
appears.

Both the Latent Period and the Infectious Period are average values over a wide range of 
environmental conditions.



Infectious Period

The Infectious Period is the number of days that the lesion continues to produce spores.

Both the Latent Period and the Infectious Period are average values over a wide range of 
environmental conditions.



Sporulation Rate

The Sporulation Rate is the number of spores produced per lesion per day, averaged 
over the infectious period.



Spore Deposition

The Spore Deposition Rate is the proportion of the dispersed spores that actually land 
on susceptible tissue.    It is a very difficult parameter to estimate empirically and may 
have to be left as a "tuning" parameter, that is, a parameter whose value is iteratively 
readjusted after comparing simulated epidemics with real epidemics.



Lesion Limit

The Lesion Limit is the upper limit on the number of lesions per unit land area.    Its 
purpose is to prevent unlimited population growth in the event of an uncontrolled 
epidemic.    This may be an awkward unit with some fungi where disease is measured as a 
proportion of tissue infected or as lesions per unit of leaf area.    However, by using an 
average lesion size and an estimate of total leaf area per unit of land area, it is possible to 
express this value in the appropriate units.



Overwintering Factor

The Overwintering factor is a simple proportionality factor to convert the final lesion 
count in one season to initial inoculum for the following season.    It is expressed as the 
number of spores dispersed (not yet deposited) at the start of the following season per 
sporulating lesion existing at the end of the season (not necessarily per overwintering 
lesion).



Daily Survival Rates

The Daily Survival Rates of Spores, Latent Lesions, and    Sporulating Lesions represent 
averages over a wide range of environmental conditions.    These are expressed as 
proportions of the respective populations.



4 or 16 Subpopulations

Resistan normally simulates four subpopulations of the Fungus.    Each subpopulation is 
either resistant or sensitive to each of the two fungicides being applied.    If you change 
fungicide selections between seasons, the level of resistance to the "old" selections will 
not be calculated during subsequent seasons.    Hence, with only four subpopulations you 
can't watch the decline in resistance to a fungicide after it is replaced with an alternative 
material.    Selecting 16 Subpopulations in the Fungicides menu causes the simulator to
use 16 subpopulations, each sensitive or resistant to each of the four fungicides 
independently.    Resistance values may be obtained from the subpopulation calculator or 
the resistance dialog box for any of the four fungicides.    Note that this option quadruples 
the number of calculations which must be performed, and will affect execution speed 
accordingly.



The Subpopulation Calculator

When the simulator is running, the last item in the Fungus menu will be 
Subpopulations....    This item invokes the subpopulation calculator with which you can 
determine the frequency of any specific subpopulation.    Use the buttons of the calculator 
to enter an expression describing the subpopulation whose frequency you wish to 
determine.    The expression will be displayed as you enter it.    When you hit the [=] 
button, the display will show the number of sporulating lesions in that subpopulation.    
When you hit the [Off] button, the calculator will disappear.

[(] and [)]

The parentheses are used as in mathematical expressions to control the order in which 
operations are performed.    In unparenthesized expressions, "and", represented as '+', 
takes precedence over "or", represented as '|'.

[CE]

This button allows you to correct mistakes in entering an expression.    Use it as you would 
the backspace key on a keyboard or the CE key on a conventional calculator.

[C]

Unlike [CE], [C] clears the display completely, allowing you to begin a new expression.

[1 Dithiocarbamate]

The four keys of this form are used to represent the four fungicides.    They won't all be 
used unless the simulator is running in the "16 subpopulations" mode.    As you enter an 
expression, the number at the left will be used to represent the fungicide whose name is 
shown.

[Sensitive] and [Resistant]

These buttons indicate sensitivity or resistance to the fungicide they follow.

Eg: 1R indicates Dithiocarbamate Resistant
                1S indicates Dithiocarbamate Sensitive
                S1 is an Error!

[And +] and [Or |]

These are the logical "and"/"or".    1R + 2R indicates that all individuals in the 
subpopulation are resistant to BOTH fungicide 1 and fungicide 2.    1R | 2R indicates that 
any individual in the subpopulation is resistant to EITHER OR BOTH of fungicides 1 and 2.

[=]

This button indicates that the expression shown is to be evaluated.    The result is the 
number of sporulating lesions which fit the description specified by the expression.

Examples:

(1R | 2R) + 3S



Sporulating lesions in this subpopulation are resistant to either or both of fungicides 1 and 
2, and all sporulating lesions are sensitive to fungicide 3.

1R | 2R + 3S
1R | (2R + 3S)

Because + takes precedence over |, these expressions are equivalent.    Sporulating lesions
in this subpopulation are either resistant to fungicide 1 or (resistant to 2 and sensitive to 
3).



Host Plant Susceptibility

Use the Susceptibility Profile to adjust the relative host susceptibility throughout the 
season.    First set the length of the season, then click on Susceptibility... in the Plant 
menu.    Move the cross-hair cursor to the desired coordinates and click to establish a new 
anchor point for the profile.    As many anchor points as desired can be established.    To 
make fine adjustments of each anchor point, locate the cross-hairs over the point (at which
time the cursor becomes an arrow again), and drag the point to the desired coordinates.    
(Note that the coordinates are displayed    on the screen while the button is down.)    
Releasing the button leaves the anchor point at its new coordinates.    Remove an anchor 
point by double clicking while the cursor is located on it.    Exit the Susceptibility Profile 
window by double clicking the close box in the upper left corner.



Damage Constant

The Damage Constant is the half-saturation constant for damage as a function of lesion 
population.    This parameter represents the lesion count at which the proportion of the 
crop lost per day is one-half its maximum.    To estimate the Damage Constant it is 
necessary to estimate the crop loss at several intensities of disease at one time during the 
season, measuring crop loss as a proportion and disease as number of lesions per unit land
area (acre or hectare).    Regress the inverse of proportional crop loss versus the inverse of 
lesions per unit area to fit the model:

                1/y = 1/m + (k/m)(1/x)

                where y is the proportional crop loss, x is lesions per unit area, m is the crop loss at
the saturation level of disease, and k is the Damage Constant, the lesions per unit area at 
half the saturation level of disease.

Obviously not all crops fit this crop loss model, and in general this kind of crop loss data is 
very difficult to get.    Remember that these functions are only used to compare fungicide 
spray schedules on benefit/cost basis and do not affect the simulation of the selection of 
fungicide resistant fungus populations. Crude approximations at this point will not seriously
affect the utility of the program for understanding the principles of fungicide resistance 
management or even comparing specific spray programs.



Length of Season

Selecting Length of Season... in the Season main menu will allow you to change the 
length of the season in days.



Starting Date

This is the calendar date of the first day of the season.    It is used as the basis for the 
labeling of the x-axis.



Costs/Price

Application Cost is the cost of a single spray application in the desired monetary units 
per unit of land area (e.g., dollars per acre).    This does not include the cost of the 
fungicide.

Fixed Costs are the total crop production costs, excluding the fungicide spray application 
cost and the cost of the fungicides, in the desired monetary units per unit of land area 
(e.g., dollars per acre).

Maximum Revenue is the expected revenue from the crop without any losses resulting 
from the disease (e.g., dollars per acre).



Show/Hide Pie Chart

At the end of each simulated season, a graphical benefit-cost analysis can be seen by 
selecting Show Pie Chart in the Economics menu.    Exit this window by double clicking 
the close box in the upper left corner, or by selecting Hide Pie Chart from the Economics
menu.



View Menu Check Items

The View menu allows you to select which of the simulation variables will be displayed on 
the graph as the season progresses.    A checked variable will be represented by a line of 
the same color as the check mark.    In this way, the View menu doubles as a legend for 
the graph.    In addition, the View menu also shows the current scaling factors for all 
variables.



Set Colors

The Set Colors command allows you to change the colors which are used to represent the
various simulation variables on the Resistan graph.    In this way, you can be sure the 
different lines on the graph are readily distinguishable, regardless of what combination of 
variables you choose to display.    The Color Choices dialog box shows all of the variables 
which can be displayed on the graph, along with their currently assigned colors.    When 
the radio button next to a variable is checked, the color for that variable can be changed 
by clicking on the new color in the palette at the bottom of the dialog.    The line next to 
the variable name will change color immediately to reflect your choice.    When a variable 
is checked in the View menu, indicating that it is to be drawn on the graph, the check 
mark will be the same color as that variable's line on the graph.



Arrange

One of the benefits of the Microsoft Windows environment for a program such as Resistan
is that it allows multiple copies (or "instances") of a program to be run simultaneously.    In 
this way, it is possible to do side-by-side comparisons with each instance of Resistan 
simulating a different situation.    The arrange command is intended to be used when 
more than one instance of Resistan is running.    Selecting this command from the View 
menu will cause all non-iconic Resistan windows to be arranged side-by-side to use the 
full screen without overlapping.



Keyboard Actions

Like most Microsoft Windows applications, Resistan is designed to use a mouse.    
Although a mouse is strongly recommended, it is not essential.    A keyboard interface has 
been provided for all of the essential features of the program.    Even when a mouse is 
present, there may be times when the keyboard interface is more convenient for certain 
actions.    Wherever possible, we have used the keystrokes that are standard among 
Windows applications.    The following is a brief summary of the keyboard interface of 
Resistan.

The Main Window

The menu system uses the standard Windows keystrokes; underlined letters in menu items
represent hot keys.    The <Alt> key followed by the appropriate hot key provides access to
a popdown menu.    For example, <Alt>, F causes the File menu to pop down.    The arrow 
keys move the highlight to different items within the menu.    Pressing <Enter> with a 
menu item highlighted is the same as selecting that menu item with the mouse.    Pressing 
the hot key for a menu item has the same effect.    While the File menu is pulled down, 
pressing 'O' invokes the Open dialog box.

The window scroll bars also use the standard keystrokes.    <PgUp> and <PgDn> operate 
the vertical scroll bar, while <Ctrl>+<PgUp> and <Ctrl>+<PgDn> operate the horizontal 
scrollbar.    Note the distinction between the horizontal window scroll, which appears at the 
very bottom of the window when it is displaying a graph that is wider than the window, and
the simulation scrollbar, which appears below the x-axis when a season is in progress and 
is used to advance the date.    The simulation scrollbar uses the <+> key to advance one 
day, or <Ctrl>+<+> to advance one week.    <End> is equivalent to dragging the thumb 
all the way to the right, and advances the simulation to the end of the season.

Dialog Boxes

<Enter> and <Esc> operate the "OK" and "Cancel" buttons, respectively.    The <Tab> key 
shifts the input focus from one control to the next.    The control with the input focus is the 
one that will respond to keyboard actions (other than <Enter> or <Esc>).    The input focus
is indicated by highlighting of the text in an edit control, or a dotted rectangle around a 
radio button.    When a radio button has the input focus, the spacebar toggles its status.    If
the button is one of a mutually exclusive group, when it is deselected, the next button in 
the group will automatically be selected.

The Colors Dialog

The Colors dialog box allows you to reassign the colors that are used to represent the 
various simulation variables on the graph.    It is a little different from most of the other 
dialog boxes.    <Tab> cycles among the currently selected radio button, the color palette, 
the "OK" button and the "Cancel" button.    When the input focus is on a radio button, the 
spacebar or the arrow keys can be used to select a different button.    When the input focus
is in the color palette, it is represented by an inverted rectangle on the current color 
button.    The focus is moved from one color button to the next by using the arrow keys.    
Pressing the spacebar while the input focus is on a color button has the same effect as 
clicking that color with the mouse; that color is assigned to the variable whose radio 
button is selected.



Getting Help

Resistan features a context sensitive help system which provides information about all 
aspects of the program,    To access the help system, press F1.    This will take you directly 
to the help item most appropriate for your current situation.    If no specific help item exists
you will be presented with the help index.    Selecting Index from the Help Menu will take 
you directly to the help index.

To get help on a menu command, pull down the menu and highlight the command using 
either the mouse or the arrow keys.    While the command is still highlighted (don't let up 
on the mouse button!), press F1.    The Help window will appear with the appropriate 
information.

To get help while in a dialog box. press F1.

If you need more general help with the Microsoft Windows ® environment, use the Help
Menu in either the Program Manager or File Manager window.

To learn more about the help system, press F1 while the Help window is active, or select 
Using Help from the Help window's Help Menu.



About Resistan

Resistan is a mechanistic simulation of the selection of fungicide resistance (Arneson, et 
al., 1988).    The simulation has been written for the Microsoft Windows ® environment 
(ver. 3.0 or higher) by Barr Ticknor and Phil Arneson, Department of Plant Pathology, 
Cornell University.    Resistan is copyright © 1992 Cornell University; all rights reserved.    
Microsoft is a registered trademark and Windows is a trademark of Microsoft Corporation.

Permission is hereby granted for this program to be freely copied and distributed subject to
the following terms and conditions:
1. All such copying and distribution must be done free of charge.
2. The program and all associated materials must not be modified in any way.
3. All of the following files must be distributed together :

RESISTAN.EXE - the main program
KEYHOOK.DLL - the keyhook library which supports the context sensitive help 

system.
RESISTAN.HLP - the help file
RESISTAN.WRI - the manual in Microsoft Windows Write format

4. If Resistan is used in the teaching of any academic course, registration is 
required.  For each course and each semester in which Resistan is used, a copy of 
the course registration form from the back of the manual must be completed and sent 
to the address given below before the program is used.    In addition, at the end of the 
course, or at the end of the module in which Resistan is used, each student must be 
required to complete a copy of the Student Questionnaire at the back of the manual.    
These questionnaires must be returned promptly to the address below.    These 
requirements are in lieu of any other payment.

Registration forms, student questionnaires, and donations in any amount to 
support the development of other programs such as this should be sent to:

Department of Plant Pathology
Cornell University
Ithaca, NY    14853
Attn: B. E. Ticknor
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